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Chapter 1
Getting Started

Introducing Autopower
Welcome to Autopower, an intuitive, yet sophisticated resistance and
power prediction program that provides naval architects and designers with
industry standard resistance and power prediction methods for
displacement, planing, semi-displacement and catamaran vessels. The limits
of each prediction method are clearly displayed, providing guidance on the
selection of the most suitable methods. Up to five different hull alternatives
can be considered simultaneously, facilitating comparative design studies
and optimization. Parameters can be easily changed for quick
recalculations.

Autopower has a fast link that enables input parameters to be imported
from our Autoship hull design / surface modeling program. High quality
graphs and tables can be displayed on-screen or printed, either directly or
via MS Word for customized reports.
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Two Versions
Autopower comes in two versions: Demo version and Full version.

The Demo version is identical to the Full version except that the Demo
version has a 30 day time limit. The Demo version may be upgraded to the
Full version by sending in the Upgrade Order Form found at the front of
this user’s manual.

Package Contents
The contents of your Autopower package, which are the same for the
Demo version and Full version, consist of:

• this user's manual

 
• a program disk

Contact Autoship Systems Corporation by phone, fax or mail if any items
are missing from your package.
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Autoship Program Suite
Autopower is part of our integrated suite of Windows programs.
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Autoship

Use Autoship to model the hull and superstructure. If installed, you can
access Autopower from Autoship by selecting Calcs-Autopower.

Autohydro

Use Autohydro to perform complete hydrostatic calculations and analyses.

Autobuild

Use Autobuild to design and model all internal structures.

Autoload

Once your vessel is built, use Autoload as an onboard load and stability
monitor.

Contact us or any of our international dealers for more information on any
of our programs.
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About This Manual
We assume you are familiar with the Windows environment. If you have
not worked with Windows before, please consult your Windows
documentation. Here is what you will find in this user's manual:

Chapter 1

Getting Started introduces you to Autopower and helps you install it.

Chapter 2

About Autopower tells you how to run Autopower and familiarizes you
with the display, keyboard and Autopower's main functions.

Chapter 3

Menu System provides information on each of Autopower’s menus.

Chapter 4

Hull Parameters describes how to enter hull parameters required to
perform resistance calculations.

Chapter 5

Calculating Resistance describes how to calculate resistance.

Chapter 6

Propeller Design and Propulsion describes how to use Autopower’s
propeller design options and to calculate propulsion.

Chapter 7

Algorithms describes Autopower’s resistance and propulsion methods.

Index
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System Requirements
Minimum Recommended

CPU 386 DX 25 MHz

with math co-

processor

486 DX2 66 MHz or

Pentium

Memory 8 Mb RAM 16 Mb RAM

Graphics Capability 640x480 resolution,

16-color VGA

monitor with

compatible video

card

1024x768

resolution, 256-

color VGA monitor

with compatible

video card

Free Hard Disk Space 5 Mb

Operating System Windows 3.1 or later version, or Windows

NT

Mouse √

Laser Printer √
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Installing Autopower

Before Installation

1. Check the Autopower program disk for the readme.wri and
history.wri  files and read them, if present, with Windows Write.
Readme.wri contains the latest comments on the installation procedure
and program use. History.wri  contains a summary of the program
revisions.

2. Disable floppy disk caching in Smartdrive before starting the
installation. Otherwise, problems may arise with the Setup program due
to disk buffering. To disable floppy disk caching, type the command
smartdrv a- b- at the DOS prompt.

3. Ensure that you have enough hard disk space - approximately 5 Mb is
required.

4. Ensure that your autoexec.bat file has the Windows directory in the
path statement.

5. If you have MS Word, ensure that your autoexec.bat file has the MS
Word directory in the path statement. This will enable you to transfer
Autopower output to MS Word.
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Installing Autopower

The installation procedure is the same for the Demo version and Full
version.

 1. Start Windows and open the File Manager.

 2. Insert the Autopower program disk into your disk drive.

 3. Enter File-Run. The Run dialog box appears. Enter a:\setup.exe or
b:\setup.exe, depending on the disk drive you are using. Click OK.
Disregard Run Minimized as this is a standard Windows option
inappropriate for Autopower.

 4. A Setup box appears while the setup files are being initialized.
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 5. Then the Autoship Directory Path dialog box appears.

 6. Enter the drive and directory where you want to install Autopower
and click OK . To use the default directory setting of
C:\AUTOSHIP\APWR, click OK  without entering anything in the
input box.
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 7. The Product Registration dialog box appears.

 8. Enter your first name, last name, and company name as you are
prompted. Use the tab key after entering each line. Click OK.

 9. The "Application Installation is Complete" message box appears.
Click OK .
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Note:  The first time you run Autopower, the Font dialog box will appear
so that you can set the font type and size to be used for printing reports.
We recommend using a regular 10-point Arial font. These settings will
remain until changed. To change these settings, select File - Page Setup
and click on the Fonts button, which will open the Fonts dialog box.

Upgrading from Demo to Full Version

If you have a Demo version, each time you run Autopower, the startup
screen will tell you how many days you have left in your 30 day demo
period. At the end of the demo period, you will not be able to operate
Autopower.

1. Complete the Upgrade Order Form found at the front of this user’s
manual and fax or mail it to us. Or, contact us by telephone and
provide us with the full information on the Upgrade Order Form.
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2. We will provide you with a 22 character Access Code which will
remove the time limitation on your Demo version and make it a Full
version.

3. Re-install Autopower following the steps under Installing
Autopower. The “Previous Installation Found...Overwrite?”
message box appears. Click Yes.

4. The "Please Wait" message box appears followed by the Demo
Version Options dialog box. Select Upgrade to Full Version. Enter
the Access Code. Click OK . If you enter more or less than the 22
character Access Code, you will be prompted to re-enter the string.
If you enter 22 characters but not the correct Access Code, the
setup program will terminate.

5. The "Installation is Complete" message box appears. Click OK .
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Chapter 2
About Autopower

This chapter gives you an overview of Autopower and covers the following
points:

• Entering and Exiting

• Mouse and Keyboard

• Main Screen

• Menu System

• Default Settings

• Resistance and Propulsion Methods
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Entering and Exiting

Entering Double-click on the Autopower icon.

Alternatively, you can open the File Manager and select
c:\autoship\apwr\apwr.exe.

Exiting Select File - Exit.
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Mouse and Keyboard
In Autopower, the mouse works the same way as it does in any Windows
program. Use the left mouse button for all selecting. The right mouse
button is not used.

Key Use It To

Character Keys Type in names and specify values.

Arrow keys Move through grids.

Enter Accept the entry you have just made.

F1 or Alt + H Open Help menu.

F2 Edit active cell.

F5 Open Resistance dialog box.

F6 Open Propulsion dialog box.

F9 Run resistance calculations.

F12 Open Save-As dialog box.

Control + F12 Open �Save existing data?� dialog box. If you enter Yes,

the Open File dialog box opens.

Shift + F12 Open Save dialog box. If file has not been named yet,

the Save As dialog box opens.

Control + Shift +

F12

Open Print dialog box. If a font has not been selected

yet, the Font dialog box opens.

Alt + F Open File menu.

Alt + E Open Edit menu.

Alt + V Open Solve menu.

Alt + S Open Settings menu.
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Main Screen
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Menu System

This table summarizes the menu system which is described in detail in
Chapter 3, The Menu System.

Menu Contains

File Menu Items for manipulating files.

Edit Menu Items for copying, pasting and clearing the Hull

Parameter Grids.

Solve Menu Items for calculating resistance and propulsion and

opening the Graph and Report windows.

Settings Menu Items for specifying water density and units of

measurement.

Help Menu Items for accessing online help.

File Edit Solve Settings Help
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Default Settings
Autopower's default settings are as follows:

• Displacement hull type
 
• Metric units
 
• Sea water density
 
• Printing is sent to the default system printer
 
• Pages are 8.5 x 11 inches with page margins 1 inch from all

four sides
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Resistance Methods
Autopower provides the following resistance methods which are described
in detail in Chapter 5, Calculating Resistance and Chapter 7, Algorithms.

Displacement
• Andersen/Guldhammer
• Fung
• Holtrop
• van Oortmerssen
• Digernes/Cheng
• Jin/Su/Tan
• Calisal
• FAO

Semi-Displacement
• Compton

Planing
• Savitsky
• Radojcic

Catamaran
• Marintek Fastcat
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Chapter 3
Menu System

Autopower's menu system consists of File, Edit, Solve, Settings, and Help
menus.

File Edit Solve Settings Help
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Chapter 5
Calculating Resistance

To calculate resistance, take the following steps:

1. Select the hull type.

2. Enter the hull parameters into the Hull Parameter Grid or import the
hull parameters from Autoship (see Chapter 4, Hull Parameters).

3. Click on the Resistance icon.

4. The Resistance dialog box opens. This dialog box contains the
resistance method(s) appropriate to the hull type you have selected.
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Resistance Dialog Box (Displacement)

 

5. Select the resistance method(s). You can use the Browse Methods box
to compare the limits of the selected method(s) against the hull
parameters of the active file.

6. Click on the Speeds button.
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7. The Speeds dialog box opens. Enter the lower, upper, interval and
service speeds. Click OK .

8. Click on the Options button.

9. The Resistance Options dialog box appears. There are four Options
dialog boxes, depending on the hull type you have selected.

Resistance Options (Displacement)
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Resistance Options (Semi-Displacement)

Resistance Options (Planing)
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Resistance Options (Catamaran)

10. Enter the following resistance options and click OK .

Option Entry

Hull Wetted

Area

This option is available for all vessel types. You must

enter the hull wetted area either by entering a user-

defined value into the Hull Parameters grid, or by

selecting one of the following methods:

• User Defined (this is the default)

• Haslar

• Denny Mumford

• Holtrop/Mennen (displacement only)

• Averaged

Form Factor

(1+k)

This option is available only for displacement vessels.

You must enter the Form Factor in the Hull Parameters

grid. Once entered, select among:

• User Defined (this is the default)

• Holtrop

• Tagano
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Option Entry

Resistance

Allowances

This option is available for all vessel types. Enter any of

the following:

• Scale Effect (% of total resistance)

• Air Resistance (% of total resistance)

• Hull Roughness (length unit)

• Propeller Diameter (length unit)

Autopower incorporates these allowances in calculating

resistance.

Chine Type This option is available only for semi-displacement

vessels. Select either:

• Hard Chine

• Soft Chine

Blount Multiplier This option is available only for planing vessels using

Savitsky method. Select either:

• Yes

• No (this is the default)

Propulsive

Coefficient

This option is available only for catamaran vessels.

Select from among:

• User defined

• Waterjet Propulsion

• Propeller with inclining shaft

• Propeller with aft body tunnel

• Z-Drive

11. Click on the Calculate button.

12. Click on the Graph  or Table icon to view the output.
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Sample Resistance Graph

Resistance Vs. Speed

Speed (Knots)

R
t
 
(
k
N
)
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400.0

500.0

600.0

700.0

800.0

900.0

Holtrop 
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Sample Resistance Table (partial)

Total Resistance, Rt (kN)

Speed (kt) Fn Holtrop
5.00 0.12 13.38

7.50 0.17 28.15

10.00 0.23 49.37

12.50 0.29 86.42

15.00 0.35 137.21

17.50 0.41 256.09

20.00 0.46 392.58

22.50 0.52 544.13

25.00 0.58 667.85

27.50 0.64 732.99

30.00 0.70 787.48

32.50 0.76 856.86

35.00 0.81 932.84

Effective Power, PE (kW)

Speed (kt) Fn Holtrop
5.00 0.12 34.41

7.50 0.17 108.61

10.00 0.23 253.99

12.50 0.29 555.72

15.00 0.35 1058.79

17.50 0.41 2305.52

20.00 0.46 4039.24

22.50 0.52 6298.34

25.00 0.58 8589.32

27.50 0.64 10369.80

30.00 0.70 12153.49

32.50 0.76 14326.27

35.00 0.81 16796.30
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Notes on Calculating Resistance

1. Browse Methods
You can use the Browse Methods box to compare the limits of the selected
method(s) against the hull parameters of the active file. When you select a
method, its limitations, if provided by the originator of the method, are
compared to those of the active file. The Browse Methods box uses the
following abbreviations:

Parameter Symbol
Froude number Fn
Volume Froude number Fv
Block coefficient Cb
Prismatic coefficient Cp
Midship section coefficient Cm
Beam-draft ratio BT
Length-beam ratio LB
Length-displacement ratio LD
Half entrance angle IE
Trim angle TR
Deadrise angle DR
Shaft angle EP
100 (LGC/Lp) LC

2.  Printing Output
You have three options for printing your graphs and tables:

• Select File - Print  from the File menu. The tables and graphs are
printed on the default system printer.

• Click on the MS Word  icon at the bottom of your report. This will
transfer your report to your active MS Word document. This
feature works with MS Word Versions 2 and 6. If you do not have
an open document, your graphs and tables will be in Document 1. If
MS Word is not open, Autopower will ask if you want Autopower
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to open MS Word. If Autopower cannot locate MS Word, it will
prompt you enter the proper path.

• Click on the Copy icon at the bottom of your report. This
transfers your report to the Clipboard. Use the Paste function in
your word processing or spreadsheet program to paste your
report. To see a copy of your report in the Clipboard, click on the
Clipboard Viewer icon in the Windows Program Manager screen
(usually in the Main directory box).
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File - Open

Use It To Load an Autopower
file (denoted with
.pwr extension) into
the Hull Parameter
Grid.

Quick Keys Control + F12 or Alt + FO

How It Works Select File-Open. The Open dialog box appears.
Select the desired file. Click OK .
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File - Save

Use It To Save all the changes
you have made to
the active file.

Quick Keys Shift + F12 or Alt + FS

How It Works Select File - Save to save all the changes you have
made to the active file. If the file has not been named
yet, the Save As dialog box opens.

Note: Since Autopower saves only the active file, we recommend that you
save your work before you switch vessel types (eg. from a displacement to
planing vessel).
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File - Save As

Use It To Save a copy of the
active file with a
new name.

Quick Keys F12 or Alt + FA

How It Works Select File - Save As. The Save As dialog box
appears. Select the file name and directory. Click
OK .
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File - Page Setup

Use It To Set up page
margins, size, font
and printer.

Quick Key Alt + FG

How It Works Select Settings - Page Setup. The Page Setup
dialog box appears. Select the desired page size,
font and printer. Click OK .
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File - Print

Use It To Print the current
report(s).

Quick Keys Ctrl + Shift + F12 or Alt + FP

How It Works Select File - Print. A message box appears showing
the percentage of the report file transferred to the
printer.
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File - Exit

Use It To Exit Autopower.

Quick Key Alt + FX

How It Works Select File - Exit. If you have an open file, the Save
Project message box appears. Click Yes or No, as
appropriate.
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Edit - Copy Cell

- Paste Cell

Use Them To Copy data from one cell to another.

Quick Keys Alt + EC and Alt + EP

How They Work Click on the cell you want to copy. Select Edit -
Copy Cell. Then click on the cell you want to
paste it to. Select Edit - Paste Cell. The data in
the original cell is now copied to the new cell.
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Edit - Copy Column

- Paste Column

Use Them To Copy data from one column to
another.

Quick Keys Alt + EO and Alt ES

How They Work Click on the column you want to copy. Select Edit
- Copy Column. Then click on the column you
want to paste it to. Select Edit - Paste Column.
The data in the original column is now copied to
the new column.
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Edit - Clear Grid

Use It To Clear the Hull Parameter Grid.

Quick Key Alt + EG

How It Works Select Edit - Clear Grid . A message box appears
asking you to affirm that you want to clear the grid.
Click Yes or No, as appropriate.
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Solve - Resistance

Use It To Open the Resistance dialog
box. This is equivalent to
clicking on the Resistance icon.

Quick Keys Control + F5 or Alt + VR

How It Works Select Solve - Resistance. The Resistance dialog
box appears. Enter all required information. (See
Chapter 5, Calculating Resistance.)
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Solve - Propulsion

Use It To Open the Propulsion dialog
box. This is equivalent to
clicking on the Propulsion icon.

Quick Keys Control + F6 or Alt + VP

How It Works Select Solve - Propulsion. The Propulsion dialog
box appears. Enter all required information. (See
Chapter 6, Propeller Design and Propulsion.)
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Solve - Calculate Now

Use It To Run resistance calcula-
tions using the active file.

Quick Keys Control + F9 or Alt + VC

How It Works Select Solve - Calculate Now. Resistance
calculations are run using the active file data. As
soon as the calculations are complete, you can view
the results by selecting Solve - Reports. (See
Chapter 5, Calculating Resistance.)
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Solve - Reports

Use It To Display and clear
reports (graphs
and, tables). Selecting Graph or Table from this
menu is the equivalent of clicking on the Graph icon
or Table icon.

Quick Key Alt + VE

How It Works Select Solve - Reports - Graph or Table.. The
Graph ot Table window appears. To print your
reports, see the note on printing output at the end of
Chapters 5 or 6.

Select Clear All  to clear your reports. Otherwise,
successive graphs and tables will be added to all
those generated since the last Clear All command.
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Settings - Sea Water

- Fresh Water

Use It To Toggle between Sea water and Fresh Water.

Quick Keys Alt + SS and Alt SF

How It Works Select Settings - Sea Water or Fresh Water. The
default setting is Sea Water. The specific gravity of
Sea water is 1.026. The specific gravity of Fresh
water is 1.0.

Note:  All Autopower calculations are based upon a water temperature of
15° C.



Settings - Metric / Imperial

36 •• Chapter 3 −− Menu System

Settings - Metric

- Imperial

Use It To Toggle between metric or imperial units.

Quick Keys Alt + SM and Alt + SI

How It Works Select Settings - Metric or Imperial . The default
setting is metric. The selected units appear at the
right side of the Hull Parameters Grid.

Standard Units

Measurement Metric Units Imperial Units

Length m ft

Area m2 ft2

Volume m3 ft3

Displacement tonnes LT

Force kN lbs

Power kW hp

Density t/m3 lb/ft3

Velocity m/sec ft/sec

Angles degrees degrees

Ship speed knots knots

Gravitational constant 9.81 m/sec2 32.20 ft/sec2
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Help Menu

Quick Key Alt + H

The Help menu contains information about Autopower and lets you access
Autopower's on-line help.
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Help - Contents

Use It To Display the on-line help table of
contents.

Quick Key Alt + HC

How It Works Select Help - Contents. The on-line help Table of
Contents appears. Click on any topic you want to
view. To return to Autopower, select File - Exit or
close the Help window.
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Help - Using Help

Use It To Learn how to use Windows help.

Quick Key Alt + HU

How It Works Select Help - Using Help. A help topic on Using
Help appears. To return to Autopower, select File -
Exit .
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Help - About

Autopower

Use It To Display the opening screen.

Quick Key Alt + HA

How It Works Select Help - About Autopower. The opening
screen appears. This screen shows the release
number, registered user and serial number. You will
need this information to upgrade from a Demo to a
Full version. Click anywhere on the screen to return
to Autopower.
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Chapter 4
Hull Parameters

Autopower has two Hull Parameter Grids for:

• displacement and catamaran hulls
• planing and semi-displacement hulls

The Hull Parameter Grid plays an important role in all Autopower work
sessions. All hull parameters must be entered unless otherwise noted in the
following tables. When you click on any hull parameter, a brief description
of that parameter appears in an information box at the bottom of the Main
Screen.
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Parameters for Displacement & Catamaran Hulls

Parameter Description Range

Project Name Project name.

LWL Length on waterline.

Breadth Breadth measured midship at design

waterline.

Draft (F) Draft forward measured at the forward

perpendicular.

Draft (A) Draft aft measured at the aft

perpendicular.
Displacement Displacement weight.
LCB Longitudinal center of buoyancy

measured as a percentage of LBP from

midship. Positive = forward, negative =

aft.

-50 - 50%

CWP Waterplane area coefficient. 0 - 1

CM Midship section coefficient. 0 - 1

Form Factor Form factor [1+k]. Default=1.

(Optional - this parameter can also be

entered in Resistance Options.)

1 - 2

Wetted Hull Area Wetted hull surface area, excluding

appendages.

(Optional - this parameter can also be

estimated in Resistance Options.)

Wetted

Appendage Area

Total surface area of all wetted

appendages.
(Enter if there are wetted appendages.)

Wetted Transom

Area

Wetted transom surface area.

(Enter if there is a wetted transom.)

Transom Width Transom width at waterline.

(Required only for Fung method.)

Half Angle of

Entrance

Half angle of entrance in degrees.

(Optional - will be estimated if not

specified.)

0 - 60°

(continued...)
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(...continued)
Parameters for Displacement & Catamaran Hulls

Parameter Description Range

Half Angle of Run Half angle of run in degrees.

(Required only for FAO method.)

0 - 60°

Angle at 1/4

Buttock

Angle at 1/4 buttock in degrees.

(Required only for FAO method.)

0 - 60°

Bulbous Bow? Bulbous bow? Yes / No Default is No.

Transverse

Bulb Area

Transverse sectional area of bulb at

forward perpendicular.

(Enter if there is a bulbous bow.)

Bulb Centroid

Location

Centroid location of bulb above keel.

(Enter if there is a bulbous bow.)

Body Type - (F) Hull form type forward of midship.

U-shaped, N (Normal), or V-shaped.

Body Type - (A) Hull form type aft of midship.

U, N, or V.

Service Margin User-specified resistance margin.

(Optional.)

0% - 50%

Appendage

Margin

User-specified resistance margin for

appendages.

(Optional.)

0% - 30%

Appendage Form

Factor

Effective form factor [1 + K2] for

appendages. See note below.

(Required only for Holtrop method.)

1 - 4

CB Block coefficient.

(Read only - calculated by Autopower.)

CP Longitudinal prismatic coefficient.
(Read only - calculated by Autopower.)
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Parameters for Planing & Semi-Displacement Hulls

Parameter Description Range

Project Name Project name.

LWL Length on waterline.

Breadth Breadth measured midship at design

waterline.

Draft Draft measured at loadline.

Chine Beam Maximum chine beam.

(Enter if there is a chine.)

Chine Length Maximum chine length.

(Enter if there is a chine.)

CX Maximum section coefficient.

(Required only for Savitsky method.)

0 - 1

Displacement Displacement weight.

LCG Longitudinal center of gravity measured

from midship to the aft perpendicular.

Half Angle of

Entrance

Half angle of entrance in degrees.

(Optional - will be estimated if not

specified.)

0 - 60°

Deadrise Angle Deadrise angle at mid-chine length.

(Enter if there is a chine.)

Wetted Hull Area Wetted hull surface area.

Wetted Transom

Area

Wetted transom surface area.

Strut Type Propeller strut configuration.

0 for single, 1 for V.

0 or 1

Shaft Angle Shaft inclination relative to buttock in

degrees.

Shaft Length Length of wetted shaft or strut barrel.

(Enter if there is a wetted shaft or a

strut barrel.)

Shaft Diameter Diameter of wetted shaft or strut barrel.

(Enter if there is a wetted shaft or a

strut barrel.)

(continued...)
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(continued...)
Parameters for Planing & Semi-Displacement Hulls

Parameter Description Range

Projected Area

of Skeg

Transverse projected area of skeg.

(Enter if there is a skeg.)

Number of Sea

Inlets

Number of non-flush sea water inlets.

(Enter if there are sea inlets.)

Projected Area of

Inlets

Frontal projected area of non-flush sea

water inlets. Enter average of frontal

areas if there is more than one inlet and

of different sizes.
(Enter if there are sea inlets.)

Rudder Type Type of rudder. See note below.

Rudder Surface

Area

Total rudder surface area.

Flap Chord Length Flap chord length.
(Enter if there is a flap.)

Flap Span to

Beam Ratio

Flap span to beam ratio.
(Enter if there is a flap.)

0 - 1

Flap Deflection

Angle

Flap deflection angle in degrees.

(Enter if there is a flap.)

0 - 15°

Service Margin User-specified resistance margin.
(Optional.)

0 - 50%

Appendage

Margin

User-specified resistance margin for

appendages.

(Optional.)

0 - 30%
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Hull Parameter Notes

1. Appendage Form Factor
Appendage Form Factor [1 + k2] is used by the Holtrop method. This

factor is derived using the wetted area of appendage components and
ranges from 1 to 4. Default values for all allowances are zero. The
following table shows the approximate [1 + k2] values.

Rudder behind skeg 1.5 - 2.0
Rudder behind stern 1.3 - 1.5
Twin-screw balance rudders 2.8
Shaft brackets 3.0
Skeg 1.5 - 2.0
Strut bossings 3.0
Hull bossings 2.0
Shafts 2.0 - 4.0
Stabilizer fins 2.8
Dome 2.7
Bilge keels 1.4

Autopower accepts an equivalent [1 + k2] factor for all appendages

combined, calculated as follows:

        (1 + k2)eq  = ∑ (1 + k2)i SAPPDi  /  ∑ SAPPDi

where SAPPDi is the surface area of the ith appendage in question.
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2. Rudder Type
You can select one of four rudder types by entering 0, 1, 2, or 3 as shown
in the table below. You must also enter a rudder surface area in the Hull
Parameter grid. Otherwise, resistance due to rudders will be zero.

Rudder

Section

Drag

Coefficient

Thickness to

Chord Ratio

Enter

NACA 0015 0.0013 0 - 15 0

Parabolic 0.0426 0 - 11 1

Flat Plate 0.0352 0 - 04 2

Wedge 0.0493 0 - 11 3

3. Autopower Files
Each file contains one hull type. This means that all of the projects within
one file must be of the same hull type, although individual projects may be
in either metric or imperial units.

4. Saving Autopower Files
Autopower saves only the data in the currently displayed grid. For example,
if you have been working on the displacement grid and then switch to the
planing grid, the File - Save operation will result in a file containing data
concerning the planing grid only (which may or may not contain any data).
Each hull type grid should be saved to a different file.
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5. Importing Hull Parameters from Autoship
You can import certain hull parameters from Autoship to Autopower. You
may be required to enter further hull parameters in Autopower before
undertaking calculations.

1. In Autoship, select Calcs - Autopower. The Autopower Setup
dialog box appears. Enter file name, hull type and draft value being
used in Autoship. Click OK .

Note:  The draft value you must use is the distance from V=0 to
the waterline. For instance, if you define the waterline to be at
V=0, then draft is zero.

2. An Open File window then appears. Enter the file name. Click OK .

Note:  Autoship uses a demi-hull for catamarans. This should be taken into
account in undertaking calculations.
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Chapter 5
Calculating Resistance

To calculate resistance, take the following steps:

1. Select the hull type.

2. Enter the hull parameters into the Hull Parameter Grid or import the
hull parameters from Autoship (see Chapter 4, Hull Parameters).

3. Click on the Resistance icon.

4. The Resistance dialog box opens. This dialog box contains the
resistance method(s) appropriate to the hull type you have selected.
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Resistance Dialog Box (Displacement)

 

5. Select the resistance method(s). You can use the Browse Methods box
to compare the limits of the selected method(s) against the hull
parameters of the active file.

6. Click on the Speeds button.
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7. The Speeds dialog box opens. Enter the lower, upper, interval and
service speeds. Click OK .

8. Click on the Options button.

9. The Resistance Options dialog box appears. There are four Options
dialog boxes, depending on the hull type you have selected.

Resistance Options (Displacement)



Calculating Resistance

52 •• Chapter 5 −− Calculating Resistance

Resistance Options (Semi-Displacement)

Resistance Options (Planing)
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Resistance Options (Catamaran)

10. Enter the following resistance options and click OK .

Option Entry

Hull Wetted

Area

This option is available for all vessel types. You must

enter the hull wetted area either by entering a user-

defined value into the Hull Parameters grid, or by

selecting one of the following methods:

• User Defined (this is the default)

• Haslar

• Denny Mumford

• Holtrop/Mennen (displacement only)

• Averaged

Form Factor

(1+k)

This option is available only for displacement vessels.

You must enter the Form Factor in the Hull Parameters

grid. Once entered, select among:

• User Defined (this is the default)

• Holtrop

• Tagano
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Option Entry

Resistance

Allowances

This option is available for all vessel types. Enter any of

the following:

• Scale Effect (% of total resistance)

• Air Resistance (% of total resistance)

• Hull Roughness (length unit)

• Propeller Diameter (length unit)

Autopower incorporates these allowances in calculating

resistance.

Chine Type This option is available only for semi-displacement

vessels. Select either:

• Hard Chine

• Soft Chine

Blount Multiplier This option is available only for planing vessels using

Savitsky method. Select either:

• Yes

• No (this is the default)

Propulsive

Coefficient

This option is available only for catamaran vessels.

Select from among:

• User defined

• Waterjet Propulsion

• Propeller with inclining shaft

• Propeller with aft body tunnel

• Z-Drive

11. Click on the Calculate button.

12. Click on the Graph  or Table icon to view the output.
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Sample Resistance Graph

Resistance Vs. Speed

Speed (Knots)

R
t
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N
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Sample Resistance Table (partial)

Total Resistance, Rt (kN)

Speed (kt) Fn Holtrop
5.00 0.12 13.38

7.50 0.17 28.15

10.00 0.23 49.37

12.50 0.29 86.42

15.00 0.35 137.21

17.50 0.41 256.09

20.00 0.46 392.58

22.50 0.52 544.13

25.00 0.58 667.85

27.50 0.64 732.99

30.00 0.70 787.48

32.50 0.76 856.86

35.00 0.81 932.84

Effective Power, PE (kW)

Speed (kt) Fn Holtrop
5.00 0.12 34.41

7.50 0.17 108.61

10.00 0.23 253.99

12.50 0.29 555.72

15.00 0.35 1058.79

17.50 0.41 2305.52

20.00 0.46 4039.24

22.50 0.52 6298.34

25.00 0.58 8589.32

27.50 0.64 10369.80

30.00 0.70 12153.49

32.50 0.76 14326.27

35.00 0.81 16796.30
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Notes on Calculating Resistance

1. Browse Methods
You can use the Browse Methods box to compare the limits of the selected
method(s) against the hull parameters of the active file. When you select a
method, its limitations, if provided by the originator of the method, are
compared to those of the active file. The Browse Methods box uses the
following abbreviations:

Parameter Symbol
Froude number Fn
Volume Froude number Fv
Block coefficient Cb
Prismatic coefficient Cp
Midship section coefficient Cm
Beam-draft ratio BT
Length-beam ratio LB
Length-displacement ratio LD
Half entrance angle IE
Trim angle TR
Deadrise angle DR
Shaft angle EP
100 (LGC/Lp) LC

2.  Printing Output
You have three options for printing your graphs and tables:

• Select File - Print  from the File menu. The tables and graphs are
printed on the default system printer.

• Click on the MS Word  icon at the bottom of your report. This will
transfer your report to your active MS Word document. This
feature works with MS Word Versions 2 and 6. If you do not have
an open document, your graphs and tables will be in Document 1. If
MS Word is not open, Autopower will ask if you want Autopower



Calculating Resistance

58 •• Chapter 5 −− Calculating Resistance

to open MS Word. If Autopower cannot locate MS Word, it will
prompt you enter the proper path.

• Click on the Copy icon at the bottom of your report. This
transfers your report to the Clipboard. Use the Paste function in
your word processing or spreadsheet program to paste your
report. To see a copy of your report in the Clipboard, click on the
Clipboard Viewer icon in the Windows Program Manager screen
(usually in the Main directory box).
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Chapter 6
Propeller Design and Propulsion

Before You Begin

Before calculating propulsion, you must have first calculated resistance
(see Chapter 5, Calculating Resistance). If you want to enter a known
resistance value for a propulsion calculation, you can undertake a nominal
resistance calculation and then edit the resistance value.

Important:  Autopower does not support propulsion calculations for
catamarans. Rather, effective power for the catamaran demi-hull is
calculated as part the resistance calculation and is shown on the resulting
resistance table. Double the effective power to account for both catamaran
hulls.

To Calculate Propulsion

To calculate propulsion, you take the following steps:

1. After calculating resistance, click on the Propulsion icon.
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2. If you have selected more than one method in your resistance
calculation, the Power Method for Propulsion dialog box will appear.
Select the desired propulsion method. The default is an average of the
methods you selected for resistance. Click OK .
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3. The Propulsion dialog box appears. This dialog box contains a number
of options required to undertake propeller optimization and calculate
propulsion.
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4. The Design Point frame in the Propulsion dialog box displays speed,
resistance and effective power values. These values are calculated from
the resistance calculation results at the specified service speed. You
may enter other speed and resistance values.

5. Enter the following options to undertake propeller optimization:

Option Entry

Type Select the propeller type:

• Wageningen B

• Ka 4-70 In 19A Nozzle

• Ka 4-70 In 37 Nozzle

• Kd 5-100 In 33 Nozzle

• Gawn-Burrill KCA

Num. Propellers Select the number of propellers:

• 1

• 2

Blades Select the number of propeller blades (Wageningen B

only):

• 3

• 4

• 5

• 6

• 7

Pitch Select propeller pitch:

• fixed

• controllable

AE/AΟΟ Select propeller expanded area ratio (Wageningen B and

Gawn-Burrill KCA only):

• 2.5% Cavitation

• 5% Cavitation

• User Defined (enter value)

Limit Diameter Select propeller limit diameter:

• From Draft

• User Defined (enter value)
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Option Entry

Wake and

Thrust

Deduction

Select among wake and thrust deduction methods:

• Holtrop

• van Oortmerssen

• Andersen

• Handbuch der Werften

• User Defined (enter values)

Relative

Rotative

Efficiency

Select among relative rotative efficiency methods:

• Holtrop

• van Oortmerssen

• User Defined (enter value)

Power Train

Efficiency

Enter value or accept default value.

6. Once you have entered the above options, you can select from three
propeller optimization methods:

• RPM, D No D Limit  - This optimizes RPM, propeller diameter
and P/D ratio without any limitation on propeller diameter.

 
• RPM, D To D Limit  - This optimizes RPM, propeller diameter

and P/D ratio subject to the maximum specified propeller diameter.
Use this method if you can accept an optimum RPM calculated by
the program.

 
• D To Limit, Vary RPM  - This optimizes propeller diameter and

P/D ratio for several discrete values of RPM, subject to the
maximum specified propeller diameter. When the calculations are
completed, the Choose Service RPM box appears with three graphs
showing (1) open water efficiency, (2) delivered power and (3)
propeller diameter, all over a range of RPM values. Use this
method if your choice of service RPM is limited (i.e. by available
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gearbox models), then choose the service RPM closest to the
optimum.

 

 
 

 Click Close to return to the Propulsion box.
 
7. The following per propeller optimization results are displayed in the

Results (Per Shaft) frame in the Propulsion box:

• Delivered Power
• Shaft Power
• RPM
• Diameter
• P/D (pitch/diameter ratio)
• AE/AΟ (expanded area ratio)
• Open Water Efficiency
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8. Click on the Power Plant button. The Power Plant box appears
displaying the following values:

• Shaft Power (power required for the service speed.)
• RPM
• % MCR (% maximum power)
 

You can edit these values to represent an available power plant and
gear box before making your propulsion calculation.

9. Click OK  in the Power Plant box. The Graph display window appears
with three graphs showing (1) resistance versus speed, (2) effective
power versus speed and (3) thrust and resistance versus speed. Click
OK  to close the Graph display window.

10. Click OK  to close the Propulsion box. To see the results of your
calculation, click on the Graph or Table icon.
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Notes On Propeller Design and Propulsion

1. Propeller Type
Autopower allows you to choose from among several propeller series
currently in use. For further information on the propeller types used in
Autopower, we refer you to the following:

• Wageningen B-Series propellers are described briefly in Chapter 7,
Algorithms and in detail in The Wageningen Propeller Series,
Kuiper, G., MARIN Publication 92-001, 1992 and in Principles of
Naval Architecture Vol. II, Resistance, Propulsion and Vibration,
Editor Lewis E.V., Published by SNAME, 1988 (pp. 186-204).

• Ducted Ka propellers with accelerating nozzles and the Kd
decelerating nozzle are described in Principles of Naval
Architecture Vol. II, Resistance, Propulsion and Vibration, Editor
Lewis E.V., Published by SNAME, 1988 (pp. 213-225).

• Gawn-Burrill KCA propeller series is described briefly in Chapter
7, Algorithms.

2. AE/AΟΟ (propeller expanded area ratio)
For ducted propellers, only the Ka 4-70 (4 blades and .7 area ratio) is
provided. For the Wageningen B and Gawn-Burrill KCA propeller series,
you may choose to have Autopower calculate the minimum AE/AΟ
allowed to limit cavitation, or enter a value of your choice.
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3. P/D (pitch / diameter ratio)
Autopower optimizes P/D in all calculations subject to the following limits:

Propeller Series Minimum

P/D

Maximum

Fixed P/D

Maximum

Controllable P/D

Wageningen B 0.5 1.4 1.25

Ka Nozzle 0.6 1.8 1.25

Kd Nozzle 1.0 1.8 1.25

Gawn-Burrill KCA 0.8 1.8 1.40

4. Wake and Thrust Deduction
You may enter your estimate of wake factor and thrust deduction factor by
selecting the User Defined method. Otherwise, they are calculated by the
selected algorithm.

5. RPM, D, No D Limit
This propeller method enables you to calculate the “ideal” propeller for the
design point speed and thrust (resistance). The resulting propeller is
unrestricted in diameter, is subject to P/D ratio limits and is designed to
achieve maximum theoretical open water efficiency.

This method may not represent a practical propeller design (i.e. the
diameter is often too large). However, it is intended to give the designer a
theoretical yardstick against which developed data can be measured. This
method enables you to compare calculated optimum efficiency against the
efficiency of the propeller optimized to the actual diameter limit.

When the efficiency of the diameter-limited propeller is significantly lower
than that of the “ideal” propeller, the designer can consider design changes
to the hull such as increasing draft. In some instances where calculated
diameter is less than the limit, (e.g. slow, low-power vessels) this method
offers an instant optimum propeller.
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6. D To Limit, Vary RPM
This method generates displays of optimal efficiency, delivered power and
propeller diameter as functions of RPM. This allows you to choose an
operating RPM (by typing it into the entry box) and to see the resulting
efficiency of that choice.

7. Printing Output
You have three options for printing your reports:

• Select File - Print  from the File menu. Your reports are printed on
the default system printer.

 
• Click on the MS Word  icon at the bottom of your report. This will

transfer your report to your active MS Word document. This
feature works with MS Word Versions 2 and 6. If you do not have
an open document, your graphs and tables will be in Document 1. If
MS Word is not open, Autopower will ask if you want Autopower
to open MS Word. If Autopower cannot locate MS Word, it will
prompt you enter the proper path.

• Click on the Copy icon at the bottom of your report. This
transfers your report to the Clipboard. Use the Paste function in
your word processing or spreadsheet program to paste your
report. To see a copy of your report in the Clipboard, click on the
Clipboard Viewer icon in the Windows Program Manager screen
(usually in the Main directory box).
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Chapter 7
Algorithms

Technical Information on Autopower�s Algorithms

This chapter contains:

• Tables comparing the applicable limits as given by the
originator of each method.

 
• Brief descriptions for each method, including background

information and form of regression equations.
 
• Brief descriptions of the propeller series used in Autopower.
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Parameter Symbols

The following symbols are used throughout this chapter:

Parameter Symbol
Froude number Fn
Block coefficient Cb
Prismatic coefficient Cp
Midship section coefficient Cm
Beam-Draft ratio BT
Length-Beam ratio LB
Length-Displ ratio LD
Half entrance angle IE
Volume Froude number Fv
Trim angle TR
Deadrise angle DR
Shaft angle EP
Length-Beam ratio LB
100 (LCG/LBP) LC
100 (LCG / Lp) -
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Applicable Limits -

Displacement

Parameter Method
Anderson
Min/Max

Fung
Min/Max

Holtrop
Min/Max

Oortmers
Min/Max

Fn    -  /0.33 0.18/0.51    -  / 1.00    -  / 0.50
Cb 0.55/0.85    -  /   -    -  /   -    -  /   -
Cp    -  /   - 0.52/0.70 0.55/0.85 0.52/0.70
Cm    -  /   - 0.62/0.90    -  /   - 0.73/0.98
BT    -  /   - 2.20/5.20 2.10 / 4.0 1.90/3.40
LB 5.00/8.00    -  /   - 3.90/14.9 3.40/6.20
LD 4.00/6.00 5.75/11.3    -  /   -    -  /   -
IE    -  /   - 4.00/16.0    -  /   - 10.0/38.0

Parameter Method
Digernes
Min/Max

Jin/Su/Tan
Min/Max

Calisal
Min/Max

FAO
Min/Max

Fn -  / 0.50 0.40 / 1.00     -   / 0.43    -  / 0.36
Cb -  /   - -  /   - 0.53 / 0.62    -  /   -
Cp -  /   - 0.57 / 0.76   -  /   - 0.55 / 0.70
Cm -  /   - -  /   -    -  /   - 0.53 / 0.93
BT -  /   - -  /   - 2.00 / 3.00 2.00 / 4.50
LB - /   - -  /   - 2.60 / 4.00 3.10 / 5.60
LD -  /   - 4.50 /  8.70 3.00 / 4.50    -  /   -
IE -  /   - 7.60 / 26.6    -  /   - 15.0 / 37.0
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Applicable Limits -

Semi-Displacement

Parameter Method
Compton
Min/Max

Fn 0.10 / 0.60
Fv 0.30 / 1.50
TR -  /   -
DR -  /   -
EP -  /   -
LB 4.00 / 5.20

100 (LCG/LBP) 37.0 / 48.0
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Applicable Limits -

Planing

Parameter Method
Savitsky
Min/Max

Radojcic
Min/Max

Fn -  /  - -  /  -
Fv >1.00 1.00 / 3.50
TR 3.00 / 7.00 0.00 / 10.00
DR 10.0 / 30.00 13.00/ 37.40
EP -  /  - 7.00 /15.00
LB 3.00 / 5.00 2.36 / 6.72

100 (LCG / Lp) -  /  - 30.00/ 44.80
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Applicable Limits -

Catamaran

Parameter Method
Fastcat

Min/Max
Fn 0.80 / 1.60
Cb -  /  -
Cp -  /  -
Cm -  /  -
BT -  /  -
LB - /  -
LD 5.75  /  7.50
IE -  /  -
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Andersen and Guldhammer

Limits of Application

Parameter Minimum Maximum
Fn - 0.33
Cb 0.55 0.85
Cp - -
Cm - -
BT - -
LB 5.00 8.00
LD 4.00 6.00
IE - -

Comments

Used for slower displacement hulls.

Background

• Based on The Technical University of Denmark preliminary design
procedure.

• No form factor is used in the formulation.
• Contains guidelines for propeller diameter reduction when behind

the hull as functions of the expanded area ratio. This is
implemented in Autopower's third (D To Limit, Vary RPM)
propeller optimization option.
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Form of Equation

CT  =  CR + CF + CA + ∆C

where
CT  : residuary resistance coefficient
CR  : residuary resistance coefficient
CF  : frictional resistance coefficient
CA : incremental resistance coefficient
∆C : air and steering resistance coefficient

Selected Reference

• A Computer-Oriented Power Prediction Procedure, Andersen P. and
Guldhammer H.E., Proceedings CADMO 86, 1986.
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Fung

Limits of Application

Parameter Minimum Maximum
Fn 0.18 0.51
Cb - -
Cp 0.52 0.70
Cm 0.62 0.90
BT 2.20 5.20
LB - -
LD 5.75 11.26
IE 4.00 16.00

Comments

Used for transom stern hulls.

Background

• Claimed to cover a broad range of hull forms and Froude numbers.
• Data used in the regression analysis include 426 transom stern

ships.
• The difference in resistance characteristics between transom and

cruiser stern ships is highlighted in the paper.
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Form of Equation

CR = CR1 + CR2 + CR3 + . . . + CR10

where
CR is the residuary resistance coefficient and
CR1 . . . CR10 are tabulated for different hull parameters 

over a range of  Froude numbers 
corresponding to 0.18 to 0.51.

Selected Reference

• Resistance and Powering Prediction for Transom Stern Hull Forms
During Early Stage Ship Design, Fung S.C., SNAME Transactions,
Vol. 99, 1991.
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Holtrop

Limits of Application

Parameter Minimum Maximum
Fn - 1.00
Cb - -
Cp 0.55 0.85
Cm - -
BT 2.10 4.00
LB 3.90 14.90
LD - -
IE - -

Comments

Used for any monohull displacement vessels. Although the maximum
Fn allowed by the algorithm is 1.00, it is not recommended that Froude
numbers greater than .4 be used.

Background

• Based on regression analysis of full-scale and model test data on
334 models at NSMB.

• The 1984 publication also used published Series 64 results.
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Form of Equation

RT = RF (1 + k ) + Rw + RAPP + RA

where
Rw : wave resistance
RAPP : appendage resistance (including bulb and transom)
RA : correlation allowance

Selected References

• A Statistical Power Prediction Method, Int. Shipbuilding Progress,
Holtrop J. and Mennen G.G.J., Vol 25, 1978.

• An Approximate Power Prediction Method, Holtrop J. and Mennen
G.G.J., Int. Shipbuilding Progress, Vol 29, 1982.

• A Statistical Re-analysis of Resistance and Propulsion Data, Holtrop
J., Int. Shipbuilding Progress, Vol 31, 1984.



Algorithms

_________________________________________________________________

Chapter 7 −− Algorithms  •• 81

van Oortmerssen

Limits of Application

Parameter Minimum Maximum
Fn - 0.50
Cb - -
Cp 0.52 0.70
Cm 0.73 0.98
BT 1.90 3.40
LB 3.40 6.20
LD - -
IE - -

Comments

Used for small vessels.

Background

• The formulae were obtained using small vessel data (trawlers and
tugs) from NSMB.

• Equations were also given for the wake factor, thrust deduction
factor and the relative rotative efficiency.

• Frictional resistance was found using the ITTC 1957 line.
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Form of Equation

RR / ∆ = C1X1 + C2X2 + C3X3 + C4X4

where
C1 ... C4 are tabulated coefficients
X1 .. X4 are parameters which are f(Cp , Fn)

Selected Reference

• A Power Prediction Method and its Application to Small Ships, Int.
Shipbuilding Progress, Vol 18, No.207, 1971.
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Digernes and Cheng

Limits of Application

Parameter Minimum Maximum
Fn - 0.50
Cb - -
Cp - -
Cm - -
BT - -
LB - -
LD - -
IE - -

Comments

Regression analysis was based on a limited number of fishing vessels.

Background

• Based on regression analysis of 34 Norwegian and 20 Danish ships.
• This simple method was compared to several other methods and

found to give good results for fishing vessels.
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Form of Equation

Rt = a (LB)b(BT)c V∂ exp(βFn)

where
a , b, c, ∂, β are constants
V : displacement

Selected Reference

• Utproving av utvalgte formler for beregning av motstand i stille vann,
Kjetil Liene, The Norwegian Institute of Fishery Technology Research
Report (FTFI).
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Jin, Su and Tan

Limits of Application

Parameter Minimum Maximum
Fn 0.40 1.00
Cb - -
Cp 0.57 0.76
Cm - -
BT - -
LB - -
LD 4.50 8.70
IE 7.60 26.60

Comments

Used for small, round bilge vessels.

Background

• This method is for fast round bilge displacement crafts such as
motor boats and workboats.

• The paper indicated that resistance is affected by the displacement
volume to length ratio, the prismatic coefficient, the transom area
to maximum sectional area ratio, the longitudinal center of
buoyancy, the half entrance angle and the Froude number.



Algorithms

                                                                                                                                         

86 •• Chapter 7 −− Algorithms

Form of Equation

CR= B0X0  + B1X1 + ... + B53X53

where
B0 ... B53 are tabulated coefficients
X0 ... X53 are parameters which are functions of geometry 

    and Fn.

Selected Reference

• A Parametric Study on High-Speed Round Bilge Displacement Hulls,
Jin P., Su B. and Tan Z., High-Speed Surface Craft, 1980.
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Calisal

Limits of Application

Parameter Minimum Maximum
Fn - 0.42
Cb 0.53 0.62
Cp - -
Cm - -
BT 2.00 3.00
LB 2.60 4.00
LD 3.00 4.50
IE - -

Comments

Regression analysis for the University of British Columbia model series
which are based on a typical purse seiner.

Background

• Formulae are derived in forms similar to those of Oortmerssen.
• Not accurate for Froude number > 0.42.
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Form of Equation

RR / ∆ = C1X1 + C2X2 + C3X3 + C4X4

where
C1 ... C4 are tabulated coefficients
X1 ..  X4 are parameters which are f(Cp , Fn)

Selected Reference

• A Resistance Study on a Systematic Series of Law L/B Vessels, Calisal
S.M. and McGreer D., Marine Technology, Vol. 30 No. 4, 1993.
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FAO

Limits of Application

Parameter Minimum Maximum
Fn - 0.36
Cb - -
Cp 0.55 0.70
Cm 0.53 0.93
BT 2.00 4.50
LB 3.10 5.60
LD - -
IE 15.00 37.00

Comments

Used for small fishing vessels.

Background

• Based on Japanese, European and other sources of data, the
regression formula was obtained using 570 model test results.
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Form of Equation

CR = CR16 - A (SL/∆) { [ log (B V/(L) .5 ] -2  -  [ log (C V(L).5 ] -2}

where
A, B, C are constants
CR16 is the residuary resistance coefficient for a standard 
16 ft model

Selected Reference

• Computer-Aided Studies of Fishing Boat Hull Resistance, Hayes J.G.
and Engvall L.O., Food and Agriculture Organization of the United
Nations, FAO Fisheries Technical Paper No. 87 1969.
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Marintek Fastcat

Limits of Application

Parameter Minimum Maximum
Fn 0.80 1.60
Cb - -
Cp - -
Cm - -
BT - -
LB - -
LD 5.75 7.50
IE - -

Comments

Used for fast catamarans.

Background

• Based on Marintek (Norway) tests on high speed slender
catamarans.

• Model to full scale correlation for high speed catamarans has been
developed based on extensive full scale experiments.

• Propulsion efficiencies are given as options in the program.
• The frictional coefficient is found using the ITTC 1957 line.



Algorithms

                                                                                                                                         

92 •• Chapter 7 −− Algorithms

Form of Equation

RT = A ( CF + CR + ∆CF ) V2 S + RAA

where
A      :  constant
∆CF  :  roughness allowance (0.0005 corresponds to hull 

roughness of approximately 150 µm)
RAA  :  air resistance allowance
S       :  total wetted hull surface area
V      :  velocity

Selected Reference

• Design Tool for High Speed Slender Catamarans, Werenskold,
Published letter from Marintek, Ocean Laboratories in Trondheim,
Norway.
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Compton

Limits of Application

Parameter Minimum Maximum
Fn 0.10 0.60
Fv 0.30 1.50
TR - -
DR - -
EP - -
LB 4.00 5.20

100 (LCG/LBP) 37.00 48.00

Comments

US Naval Academy YP Series.

Background

• Based on experimental investigations of a systematic series of small
semi-displacement models.

• Both soft and hard chine crafts are accommodated.
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Form of Equation

CR * 103 = A + B (LB) + C (∆) + D (100 [LCG/LBP] )
where
A, B, C, D : tabulated coefficients
∆               : displacement based on LBP

Selected Reference

• Resistance of a Systematic Series of Semi-Planing Transom-Stern
Hulls, Compton R.H., Marine Technology, Vol 23 No. 4, 1986.



Algorithms

_________________________________________________________________

Chapter 7 −− Algorithms  •• 95

Savitsky

Limits of Application

Parameter Minimum Maximum
Fn 0.60 1.79
Fv >1.00 -
TR 3.00 7.00
DR 10.00 30.00
EP - -
LB 3.00 5.00

100 (LCG/Lp) - -

Comments

Constant deadrise.

Background

• Resistance and trim are calculated in the preplaning (where 1.00 <
Fv < 2.00 ) and planing (Fv ≥ 2.00) regimes for prismatic planing
hulls.

• The user can also use the Blount multiplier, a correction ratio to
compensate for hump-speed resistance under-prediction using the
pure Savitsky method.

• Wave added resistance is not considered in this program.
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Form of Equation

Preplaning Regime : RT/∆ = A1F1 + ... A27F27

where
A1  ... A27 : tabulated coefficients
F1   ... F27  : f(entrance angle, max chine beam, ∇)

Planing Regime    : RT = ∆ tan(TR) + F(hull parameters,TR,Speed)

Selected References

• Hydrodynamic Design of Planing Hulls, Savitsky D., Marine
Technology, Vol. 1 No. 1, 1964.

• Small-craft Power Prediction, Blount D.L. and Fox D.L., Marine
Technology, Vol. 13 No. 1, 1976.

• Procedures for Hydrodynamic Evaluation of Planing Hulls in Smooth
and Rough Water, Savitsky D. and Brown W., Marine Technology,
Vol. 13 No. 4, 1976.
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Radojcic

Limits of Application

Parameter Minimum Maximum
Fn - -
Fv 1.00 3.50
TR 0.00 10.00
DR 13.00 37.40
EP 7.00 15.00
LB 2.36 6.72

100 (LCG/Lp) 30.00 44.80

Comments

Used for hard-chined planing hulls.

Background

• Based on Series 65-B, TMB-62 and DL-62-A hulls.
• Transom flap effects are based on Savitsky and Brown (see

Savitsky algorithm).
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Form of Equation

R/∆ = A0X0 + ... A26X26

TR   = B0X0 + ... B26X26

where
A0  ... A26 : tabulated coefficients
B0  ... B26 : tabulated coefficients
X0  ... X26  : f(hull parameters)

Selected Reference

• An Engineering Approach to Predicting the Hydrodynamic
Performance of Planing Craft Using Computer Techniques, Radojcic
D., Trans RINA, 1991.
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B-Series Propellers (MARIN)

The B-series of propellers are among the most popular to date. Thrust and
torque coefficients are represented by polynomials (see reference) in terms
of the following propeller parameters: advance ratio J, pitch ratio P/D,
expanded area ratio AE/A0 and number of blades Z.

KT = f ( J , P/D , AE/A0 , Z )
KQ = f ( J , P/D , AE/A0 , Z )

The following parameter ranges are applicable:

• P/D      : 0.50 - 1.40
• AE/A0  : 0.30 - 1.05
• Z          : 3 - 7

A Reynolds number correction is required for Rn > 2 x 106.

The propeller open water efficiency is given by:

η0 = J/2π KT / KQ

Except where the user chooses a value, the optimization algorithm sets the
expanded area ratio to the smallest value consistent with the chosen back
cavitation limit. An initial estimate is obtained from Keller’s formula and
this is refined in each solution iteration by applying Burrill’s formula. The
number of blades is normally dictated by vibration considerations. Propeller
diameter is limited by considerations of hull clearance and adequate
immersion in the ballast condition. Propeller RPM should be chosen with
regard to engine and transmission gear limitations. Depending on the
optimization mode chosen, a range of pitch ratios and RPMs/propeller
diameters are used to determine the optimum open water efficiency.
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Selected Reference

• Principles of Naval Architecture Vol II, Resistance, Propulsion and
Vibration, Editor Lewis E.V., Published by SNAME, 1988.
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Gawn-Burrill KCA Series

Thrust and torque coefficients are represented by polynomials (see
reference below) in terms of the following propeller parameters: advance
ratio J, pitch ratio P/D, expanded area ratio AD/A0. The polynomials are
given for 3-bladed propellers only.

KT = f ( J , P/D , AD/A0 )
KQ = f ( J , P/D , AD/A0 )

The following parameter ranges are applicable:

• P/D      : 0.80 - 1.80
• AD/A0  : 0.50 - 1.10
• Z          : 3
• J          : ≥ 0.3

The minimum back cavitation design criterion results in the required
developed area ratio to be:

AD/A0 = A KT f ( w , σ0 , J , P/D )

where A : constant depending on the degree of allowed 
     back cavitation.

          w : wake factor
          σ0 : cavitation number based on advance velocity

Propeller diameter is limited by considerations of hull clearance. Propeller
RPM should be chosen with regard to engine and transmission gear
limitations. Depending on the optimization mode chosen, a range of pitch
ratios and RPMs/propeller diameters are used to determine the optimum
open water efficiency.
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Selected Reference

• An Engineering Approach to Predicting the Hydrodynamic
Performance of Planing Craft Using Computer Techniques, Radojcic
D., Trans RINA, 1991.
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Ducted Propellers (MARIN)

Autopower provides a choice of three ducted propeller series:

• Ka 4-70 (4-blade propeller, AE/A0 = 0.70) in 19A nozzle
• Ka 4-70 (4-blade propeller, AE/A0 = 0.70) in 37 nozzle
• Kd 5-100 (5-blade propeller, AE/A0 = 1.00) in 33 nozzle.

The properties of these combinations are discussed in Lewis (see reference
below). The formulae for total thrust coefficient and torque coefficient are
polynomials in P/D and J.

Selected Reference

• Principles of Naval Architecture Vol II, Resistance, Propulsion and
Vibration, Editor Lewis E.V., Published by SNAME, 1988.
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INDEX

—A—
AE/AO, 62, 66
Algorithms, 69-103
Andersen, 75-76
Angle at 1/4 buttock, 43
Appendage form factor, 43, 46
Appendage margin, 43, 45
applicable limits, 71-74
Autobuild, 4
autoexec.bat file, 7
Autohydro, 4
Autoload, 4
Autopower, 1
Autoship, 4

—B—
Blades, 62
Block coefficient, 43
Blount Multiplier, 54
Body Type - (A), 43
Body Type - (F), 43
Breadth, 42, 44
Browse Methods, 50, 57
B-Series propellers, 66, 99-100
Bulb Centroid Location, 43
Bulbous Bow, 43

—C—
Calculate button, 54
Calculating Resistance, 49-58
Calisal, 87-88
catamaran propulsion, 59

CB, 43
Chine Beam, 44
Chine length, 44
Chine Type, 54
Choose Service RPM box, 64
Clear Grid, 30
CM, 42
Compton, 93-94
Copy Cell, 28
Copy Column, 29
Copy icon, 58
CP, 43
CPU, 6
CWP, 42
CX, 44

—D—
Deadrise angle, 44
default settings, 18
Demo version, 2, 8, 11-12
Design Point, 62
Digernes, 83-84
disk space, 6
Displacement, 42, 44
Draft, 44
Draft (A), 42
Draft (F), 42
Draft aft, 42
Draft forward, 42
draft value, 48
ducted propellers, 66, 103
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—E—
Edit-Clear Grid, 30
Edit-Copy Cell, 28
Edit-Copy Column, 29
Edit-Paste Cell, 28
Edit-Paste Column, 29
entering, 14
exiting, 14
expanded area ratio, 62, 66

—F—
FAO, 43, 89-90
Fastcat, 91-92
File-Exit, 27
File-Open, 22
File-Page Setup, 25
File-Print, 26
File-Save, 23, 47
File-Save As, 24
Flap chord length, 45
Flap deflection angle, 45
Flap span to beam ratio, 45
Fonts, 11, 25
Form factor, 42, 53
fresh water, 35
Full version, 2
Fung, 77-78

—G—
Gawn-Burrill KCA Series, 101-102
Graph icon, 54
graphics, 6

—H—
Half angle of entrance, 42, 44

Half angle of run, 43
Help menu, 37-40
Help-About Autopower, 40
Help-Contents, 38
Help-Using Help, 39
Holtrop, 46, 79-80
hull parameters, 41-48
Hull Parameter Grids, 41-45
Hull-Wetted Area, 53

—I—
importing parameters, 48
information box, 41
installation, 7-12

—J—
Jin, 85-86

—K—
keyboard, 15

—L—
LCB, 42
LCG, 44
Length on design waterline, 42
limit diameter, 62
limits for methods, 71-98
Longitudinal center of bouyancy, 42
Longitudinal center of gravity, 44
LWL, 42, 44

—M—
main screen, 16
Marintek Fastcat, 91-92
Maximum section coefficient, 44
MCR, 65
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memory, 6
menu system, 17, 21-40
Midship section area coefficient, 42
mouse, 15
MS Word icon, 57

—O—
Oortmerssen, 81-82
operating system, 6

—P—
package contents, 2
Page Setup, 25
parameter grids, hull, 42-45
parameter symbols, 57, 70
Paste Column, 29
Paste-Cell, 28
pitch/diameter ratio, 67
power method, 60
Power Plant DB, 65
Power train efficiency, 63
Print, 26
Printing output, 57, 58, 68
Prismatic coefficient, 43
Project Name, 42, 44
projected area of inlets, 45
Projected area of skeg, 45
propeller design, 59-68
propeller optimization, 60, 63, 67, 68
propeller optimization methods, 63-64
propeller pitch, 62
propeller type, 62, 66
propulsion, 59-68
Propulsion DB, 61
propulsion icon, 59
Propulsive Coefficient, 54

—R—
Radojcic, 97-98
relative rotative efficiency, 63
Reports, 34, 55-58
Resistance Allowances, 54
resistance methods, 19, 69-98
Resistance Options, 51-54
RPM, 63, 65, 67, 68
Rudder Surface Area, 45
Rudder Type, 45, 47

—S—
Save As, 24
Savitsky, 44, 95-96
Sea Inlets, 45
sea water, 35
sea water inlets, 45
Service margin, 43, 45
Settings-Fresh Water, 35
Settings-Imperial, 36
Settings-Metric, 36
Settings-Sea Water, 35
Shaft Angle, 44
Shaft Diameter, 44
Shaft Length, 44
Solve-Calculate Now, 33
Solve-Propulsion, 32
Solve-Reports, 34
Solve-Resistance, 31
Speeds button, 50-51
Strut Type, 44
system requirements, 6

—T—
Table icon, 54
thrust and resistance graph, 65
Transom width, 42
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Transverse bulb area, 43
Type, propeller, 62

—U—
units, 36
upgrading, 11-12
Using Help, 39

—V—
van Oortmerssen, 81-82
Vary RPM, 63, 68, 75
versions, 2

—W—
Wageningen, 66, 99-100
Wake and thrust deduction, 63, 67
Waterplane area coefficient, 42
Wetted appendage area, 42
Wetted hull area, 42, 44
Wetted transom area, 42, 44
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